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What is SecureCom?


 


  SecureCom for Windows 95/NT is a small and fast personal communication tool for Windows 95 and Windows NT.  It is designed to hook two people up directly (without using the IRC channels, servers, IP servers, etc.) for a one-on-one  personal text mode chat.





  SecureCom for Windows 95/NT utilizes two separate "Hailing features" to accomplish this.  The main Hailing feature uses a built in seamless e-mail facility to send your current IP address to another SecureCom user in a specially coded e-mail letter.  The other user (who is checked into the net and has SecureCom running) will receive the message and prompt him to either connect or not connect.  The secondary Hailing feature sends Hailing messages directly to a known IP address using TCP/IP and can be used on a local network as well as the internet (if you know the IP address already for the party you want to connect to).





  The SecureCom Monitor ON mode checks your mail box (at user set intervals) for SecureCom (e-mail based) Hailing messages.  If it detects SecureCom Hailing messages it downloads them, deletes them from the server, and prompts you to see if you want to attempt a connection. 





  SecureCom also has a separate monitor facility for Direct Hailing (which doesn't use e-mail facilities).  Please read the Direct Hailing section for details on using it for both local networks and for the internet.





  If you decline to connect when you are prompted by an incoming (e-mail based) Hail message SecureCom will save the hailing message(s) in the Hail log.  The Hail log can also be used to make a connection - assuming the message is not so old that the person hasn't logged off the internet, turned off SecureCom, or logged off and back on with a new IP address. 





  Once SecureCom gets an IP address from the SecureCom Hailing message it can then directly connect you with the other party.  The ONLY use of the e-mail system is to initially exchange an IP address.





  One button Hailing makes it a simple and painless way to connect.





  No other servers, e-mail or support software are needed.




















Why is SecureCom - and who is it for?





  SecureCom for Windows 95/NT has primarily been written to give Windows 95/NT platform a low overhead, personal, and direct chat program compatible with an existing version on the OS/2 platform.





  It's main goal is to stay as lean and as fast as possible.  I have no intention of adding features until it becomes a multi-megabyte bloatware wonder.





  I do intend to make it better and to add numerous enhancements or features but I do not intend to change the basic scope and goal of the program.  it is intended to be a one-on-one chat program and will remain that way.   





  It was also written because of my general dislike of the IRC Chat channels.  My limited experience there has not generally been a good one.   





  That's why SecureCom does not rely on IRC channels or any other extraneous servers - or the mercy of their owners.  It also does not rely on any servers to see who is on line.





  It will remain that way.





  So, if you want to talk to many, many people and remain anonymous then this program is not for you.  If you want to get on and chat with people about sex fantasies and act like adolescents, perverts, or worse then this may not be what you want.  This program is for people who want to communicate with friends, business acquaintances, or family members - people they know.




















Shareware notice


These programs are shareware and are not free.  It is expected that after 30 days of trial use you either erase the software and stop using it or you register it. 




















Distribution 





These programs can be freely distributed by any means as long as all the original files remain together and are not altered.  They cannot be used for any commercial purpose or sold without first obtaining the authors permission. 




















Requirements for SecureCom for Windows 95/NT 





  SecureCom for Windows 95/NT should run well in machines with relatively small amounts of memory.  It has been tested in Windows 95 and Windows NT 4.0.  It was created and compiled with Borland C++ builder on Windows NT 4.0.





  It also requires you to have TCP/IP installed and an internet provider with an e-mail account to send and receive SecureCom Hailing messages.





  SecureCom does not require any IRC servers, IP servers, additional e-mail programs, or anything else to function properly.





  *America On Line users. SecureCom will work with AOL 3.x (AOL 4.x not released or tested as of this writing) on Windows 95.  However, ONLY Direct Hailing can be used - not e-mail based Hailing.  SecureCom does NOT work at all with AOL on Windows NT.  Please read the AOL section for updated details.  




















Installing SecureCom for Windows 95/NT





  After you have unzipped the SC100W.ZIP file, copy SECOM.EXE and ReadSC.DOC to a directory (folder) and put a shortcut on your Desktop for SECOM.EXE.  SecureCom will create (during use) several data files, temporary files and it's own .INI file.





  The ReadSC.DOC help file is not required for SecureCom to function properly but is required if you want or need to access the SecureCom help file through the Help menu.





  If you are already registered you must also copy your main.key file to the same folder as the SECOM.EXE file to keep the program registered.




















Using SecureCom 





  SecureCom should have it's Internet Acct. settings page completely filled out before going on to the Quick Start section or the Details on using SecureCom section.





  General use of SecureCom consists of connecting with another user and typing text in the lower entry field area (local) and pressing ENTER when you want to send the text to the person you are connected to.  The text you type locally and send is also echoed to the upper entry field area (remote). 





  The upper entry field area is also where you will see the messages appear from the person you are connected to.  





  This makes the Nickname setting in the Internet acct. settings dialog very important since each message is preceded by the senders nickname.  This makes it easier to differentiate the origin of the numerous messages in the upper entry field area.  Otherwise it could be difficult to tell who typed which message.





  Also, all messages originated locally and echoed in the upper entry field area have the Nickname encased in the less than symbol (<) and the greater than symbol (>).





  Messages originated by the remote party will be encased by the left square bracket symbol ([) and the right square bracket symbol (]).




















Initial Setup for SecureCom 





  SecureCom has 4 sets of configurations - 4 menu items under the main menu item Configure.





  ONLY the first two (Internet Acct. settings and Misc. settings) need be filled out and completed before going to the Quick Start section of this .INF file.





  Actually, only the Internet Acct. settings are critical to get started, though you may want to change or add a few things on the Misc. settings page.








Internet Acct. settings 





  There are two sets of settings fields for internet acct. settings.  The first set is for receiving Hail messages and the second set is for sending Hail messages.  There is also a setting at the bottom for your nickname which is used when you connect with someone.





  All entry field settings should be filled out on this page.





Settings for receiving hailing messages 





Pop server --  This is supplied by your internet service provider.  It should be the same as the pop mail server used by your e-mail program to receive mail.  (example : mail.myisp.com)





Mail address -- Enter your e-mail address in this field.  (Example : johndoe@myisp.com)





Password -- This is your password for your ISP.  Password identification is necessary so that SecureCom can monitor your email account for SecureCom Hailing messages (if in fact, this function is a desired feature to be utilized by the user).





Settings for sending hailing messages 





SMTP server --  This is supplied by your internet service provider.  It should be the same as the smtp mail server used by your e-mail program to  send mail.  (Example : mail.myisp.com)





Mail address -- Enter your e-mail address in this field.  (Example : johndoe@myisp.com)





Password -- This is your password for your ISP.  Password identification is necessary so that SecureCom can send Hailing messages.





Reply to address -- The full address you want people to send e-mail to when writing you.  This field (together with the Reply to name) will be displayed on the "You are being Hailed!" dialog when you send a hail message to someone.  For most people this field will just be their 


complete e-mail address - the same as entered under Mail address above.





Reply to name -- Your full real name is entered here - Not your user name.  This will be added to the Reply to address (described above) and be displayed on the "You are being Hailed!" dialog when you send a hail message to someone.  (Example : John Q. Doe)





Nickname Settings 





Nickname -- A real name (or alias) identification string that will immediately precede any text entered into the Local Entry Field and then sent to the remote user via the Remote Entry Field.  eg:  If your name was Gary and you typed in the Local Entry Field:  "Have a nice day today!"  the text output contained in the Remote Entry Field which is being transmitted to the other person would be formatted in the following manner: "<Gary> Have a nice day today!"  Most people may prefer to use their real first name while others may prefer to use aliases ... or whatever.  Hint:  Nicknames can be changed while connected.








Misc. Settings ...





Monitor mail interval --  This is to set how often you want SecureCom to check your mail box for SecureCom Hailing messages when you are in Monitor ON mode.





Default download dir. -- This is where you set your default download directory for files being transferred to you by another SecureCom user while you are connected.  You will be prompted by a dialog when you accept a file transfer request and that dialog will open in your default download directory.





Default upload dir. -- This is where you set your default upload directory for files being transferred by you to another SecureCom user while you are connected.  You will be prompted by a dialog when you start a file transfer and that dialog will open in your default upload directory.





Default reset ports -- This is where you set your default reset ports for the button on the Port settings page.  Whatever ports you enter in these fields will be what is shown on that button.





Force SecureCom to use machine (network) IP  --  This should not be checked unless you are on a local network and want to have two copies of SecureCom use their local machine IP's to connect.  Even then it may not always be necessary to check it IF you use Direct Hailing on your Lan ...  All internet users would not normally check this setting. 





Start Phrase list at program startup -- This would be checked if you use the Favorite Phrase dialog all the time and want it to start at the same time that you start SecureCom.





Start SecureCom minimized -- This should be checked if you want SecureCom to be minimized or hidden when initially started.





Unhide and bring to the front when hailed -- This should be checked if you want SecureCom, while monitoring your mail box in Monitor ON mode and hidden or minimized, to unhide itself and come to the front when it detects a Hailing message.  The Hailing dialog itself always prompts you but this will unhide the program itself.





Prompt when dragging and dropping files to send -- This would be checked if you want to be prompted by a dialog when you drop files into the bottom entry area.  This keeps you from accidentally starting a file transfer and also gives you the added option of pasting the dropped file (if it is a text file and is less than 4k) into the entry field instead of sending it, if desired.





Prompt when closing SecureCom -- This would be checked if you want to be prompted with a "Are you sure?" dialog when you close SecureCom.





Notify if NETCHAT Hail messages are detected -- This would be checked if you think that you may still be Hailed by a NetChat user (former name of earlier versions of SecureCom).  If you select this SecureCom will notify you in the status bar IF you have a NetChat Hail message in your mail box.  However, since SecureCom is NOT compatible with NetChat you must start a copy of NetChat to actually download and process the Hail.





Show elapsed time on connect -- This would be checked if you want to see the elapsed time counter displayed on the main menu bar after you connect with someone.    





Beep me when ... --  SecureCom beeps you for a variety of reasons and at a variety of times.  If you don't like to hear most or some of the beeping deselect the ones that you choose to not hear.  In most cases you are still given a visual notification in the titlebar.





Enable TCP/IP Direct Hail monitoring   -- This would be checked if you want to turn on the internal SecureCom mini-server that monitors for Direct Hail messages.  You can also select whether you want to monitor locally on the Lan or on the Internet.  The port setting should NOT be changed unless you have problems making Direct Hail work and you know what you are doing.  For more details see the Direct Hailing section.  Also, you can turn the Direct Hail mini-server monitor on without having to open the settings page by holding down on the CTRL key while and double-clicking on the status bar at the bottom of SecureCom.





  Subsequent double-clicking on the status bar WHILE you hold on the CTRL key will toggle the state of the server from monitoring your Internet or default address (blue) to that of the local network address (red).





  Holding down on the SHIFT key while clicking on the status bar will completely shut off the mini-server monitor (black).








Port settings ...





  Most casual SecureCom users will not want to change these settings.  The standard port for SecureCom users to talk to one another is 6667.





  However, some users might, for several reasons, wish to change the port settings.  If you do change the port settings be aware that there is always the potential that another application or the system itself may already be using it.  





  Only one program at a time on the same machine can use the same port.





  It is generally recommended that you stay in the 6665-6675 range.  it is less likely that you will have any conflict in this range.





  For file transfers the SecureCom default is port 21 - the standard port used for FTP on the internet.  It is generally recommended not to change this port.  however, if you do - it is recommended to use the 6665-6675 range.





  I have tried many settings for the ports and have never experienced any serious difficulty or any problems so the recommendations above may be considered as generally conservative.





  Ports can not be changed while you are connected.





  Also, it stands to reason, that if you are FTPing with another program and try to transfer a file with SecureCom at the same time it will fail if you have the file transfer port set to port 21.  Only one program at a time on the same machine can use the same port.





  The Reset button at the bottom of the dialog can be used to quickly reset the ports to your defaults.  Your default ports (shown on the button) can be set by the user on the Misc. settings section.








PGP settings ...


   


   See the PGP support  section for PGP setup and settings details.




















Quick start 





  To get up and running fast first make sure you have filled in all the appropriate Settings for SecureCom as described in Internet acct. settings ... (and optionally, the Misc. settings ... dialogs).  Port settings usually should NOT need to be changed from their defaults.





  Then, if you want to test and make sure your pop/smtp mail settings are working correctly with SecureCom (as well as a few other things) do the following : 





1.  Select Misc. on the main menu bar.





2.  Select Hailing list on the sub menu.





3.  Select Add from the menubar at the top of the Hailing list.  In the Add a record dialog put YOUR name in the first entry area and YOUR e-mail address in the second area.





4.  Add other entries for anyone else you want to try and connect with that already has SecureCom.





5.  Close the Hailing list and then close SecureCom.





Then, to test and see if it's working :   





1.  Log onto the Internet 





2.  Start SecureCom 





3.  Shut down any programs that automatically download your new incoming mail.





4.  Press the Monitor OFF button (on the button bar) once (it will go to Monitor ON mode and turn Red)





5.  Press the Hail button on the right end of the button bar.





6.  Select the entry you put in for yourself in the list box and either double-click on it or click once on the Hail now menu item.  (You should  see the Listen OFF button go to Listen ON mode at this time and turn Yellow)





  SecureCom should report (in the titlebar) in a few seconds or so that a Hailing message has been successfully sent.  In a minute or so SecureCom will detect the Hailing message you just sent yourself and Notify you that you are being hailed.





  When it does (assuming that all is working well) look and see if it is reporting your correct current IP address - assuming you know it.  Hit the cancel button.  No need to try and connect with yourself.  (especially since it won't work properly doing it in this manner for this test)





  If all this works OK then you can now send a Hailing message to someone else on the net using SecureCom and try to connect.





  When you receive a Hailing message (and SecureCom is running and the Monitor OFF/ON button is in Monitor ON mode) you will be prompted by a dialog and a beep.  You will see who is calling, their IP address, any messages they sent in the entry field below the list box and you can select either to Connect or not to.  Whether you connect or decline, the hailing message will be saved to the hailing log.  The hailing log can also be used to connect with someone just like the original notification dialog that prompted you for a decision on an incoming Hail - assuming the person hasn't shut down SecureCom and is still on the net in Listen ON mode.  This can be useful if you don't want to connect immediately when you are first Hailed.





  If you decide to connect, SecureCom goes through a connect process.  If it is successful you will be notified in the titlebar and the Listen ON button (Yellow) will turn to a Connected! button (RED).  Finally you will hear a beep and should see a connection announcement in the upper entry area letting you know that you are now connected to someone.





  Note : If you ever download a Hailing message into your regular mail program don't panic.  Just look at the HEADER of the message and copy the IP address out of it -- right after the characters : &&$~SECURECMSG~$&& in the subject : area.  Then take the IP address and paste it into the Manual Connect dialog.  See Connecting with Manual connect for details on that feature.





  Note : Windows 95 users will hear several .WAV files instead of beeps. 





Quick start PLUS 





To fully test SecureCom ENTIRELY on your own computer by yourself you could do the following : 





1.  After you have filled out ALL the Internet Acct. settings and are ready to test, open the folder where SecureCom is located.





2.  Put a shortcut on your Desktop for the SECOM.EXE executable file.  





3.  Log onto the internet.





4.  After logging onto the net, then double-click on the SecureCom shortcut to start a sessions of SecureCom.





5.  The move that session of SecureCom to the side of the screen and double-click on the SecureCom shortcut to start a second session.





6.  Press the Monitor OFF button on session 1 and that will make the button go to Monitor ON mode (Red).





7.  Now, both sessions should be in Listen OFF mode and session 1 should be in Monitor ON mode (monitoring your mail box for Hail messages).  





8.  Then Hail yourself (as described in the previous section) with SecureCom session 2 (click on the Hail button, etc.).





9.  Since SecureCom copy 1 is already in Monitor ON mode (and copy 2 is NOT) it will detect the Hail message in a moment (be patient) and notify you.





10.  When it notifies you with the "You are being hailed!" dialog just press the Connect button and the two sessions of SecureCom will connect.





  You can now talk to yourself!  However, don't tell any of your friends this ..... they may not totally understand and may try to commit you to an institution .....





  The session can be terminated by simply pressing on the Red "Connected!" button (formerly, Listen ON/OFF).  It will break the connection and put the button back into Listen OFF mode.





note : If you are registered you will ONLY stay connected for about 90 seconds because both sessions are using your SAME registration key file.  Registered users can get around this by bringing up the Registration dialog and temporarily taking their name out of the entry field to deregister the program.  SecureCom will terminate any connection between copies/sessions running the same EXACT registration key.





More experimenting and playing around ...





  There is an alternative method (Manual Connect) for connecting with SecureCom.  You don't have to use the hailing message system at all to connect with SecureCom.  It is merely included as a convenience.  If you exchange an IP address through a regular e-mail letter, over the phone, or through ESP -- that is all you really need.  If you get the IP address and want to connect to your other party (who is using SecureCom) then you COULD use Manual Connect.  Here is how you can test the Manual Connect feature : 





1.  Start 2 sessions of SecureCom as explained above and then put session 1 in Listen ON mode (Yellow) by pressing the Listen OFF button.  Leave session 2 in Listen OFF mode. 





2.  Select the File menu item and then select the Manual Connect menu item on session 2.





3.  In the manual connect dialog type in your current IP address.  Hint : You can get your current IP address by selecting File on the main menu bar and then selecting Current IP address on the sub menu.  





4.  After typing in your current IP address in the Manual Connect dialog on session 2 then press the Connect button.





5.  Since session is in Listen ON mode (listening for a connection as noted in it's status bar) and session 2 is NOT then the 2 sessions should connect and notify you accordingly.





  Connections usually take 1-8 seconds to complete under normal circumstances over the internet.  Locally, while testing it takes less time.  





  Once connected you type text in the bottom white area and press enter to send it.  Both your text and the other person's will show in the upper entry area (cyan).   





  The session can be terminated (by either party) by simply pressing on the Red "Connected!" button (formerly, Listen ON/OFF).  It will break the connection and put the button back into Listen OFF mode.





  Reconnection can be accomplished by either party going back into Listen ON mode and the other party using the Manual Connect -- assuming neither party has logged off the internet and/or changed their IP address.  You could also reconnect by just Hailing the other party again.





And more yet for the brave at heart ...





  There is YET another alternative method (Direct Hailing) for connecting with SecureCom.  You don't have to use Manual Connect OR regular Hailing (using e-mail facilities).  The Direct Hailing method, like Manual Connect requires you to know the other party's IP address.





1.  Start 2 sessions of SecureCom as explained above and this time select Configure on the main menu bar of session 1. 





2.  Then select Misc. Settings.





3.  On the Misc. Settings dialog select the "Enable TCP/IP Direct Hail monitoring" checkbox to enable that feature.  Depending on whether you are doing this test while logged onto the internet or the using the lan address select the appropriate radio button below the checkbox. 





4.  After you save this setting, the session 1 status bar should change color to indicate that a small built in mini-server is monitoring for Direct Hail messages.  Blue for internet or default interface and Red for Lan.





5.  NOW ..... On session 2 hold down on the CTRL key and at the SAME time click on the Hail button on the button bar.





6.  That should bring up a special Direct Hail dialog instead of the usual Hailing list (because you held down on the CTRL key when you


clicked on it).





7.  Type in the current IP address and press the Hail button.





8.  Since session 1 is monitoring for Direct Hailing it should be notified in a few seconds.





9.  When session 1 is notified it will prompt you with a special dialog asking you to accept or decline the hail.  Accept the Hail and the two copies will connect.  





  


   Direct Hailing can be used on the Lan or the Internet if you know the IP address of the machine you want to Hail.  For more details on Direct Hailing and how you can obtain a "permanent" IP address on a dial up connection see the section on Direct hailing.




















Details on using SecureCom 





  To summarize, SecureCom can connect you in basically two ways.  Either exchange an IP address in whatever fashion you wish and then use Manual Connect or use either of the built in Hailing functions (Hail button) to do all the work for you.





  See the various sub-headings under this section for full descriptions of all the features in SecureCom and other pertinent information.








Sending and receiving (e-mail based) Hail messages ...





  E-mail based Hailing (See Direct Hailing for information on that feature)





  Sending a hailing message is easy.  Once you have added some people and their e-mail address to your Hailing list.  





  The Hailing list is a small database to enter and keep a record of e-mail addresses for the people you regularly want to connect with.  The Hailing list can be accessed under the menu item Misc. on the main menu bar or simply by clicking on the Hail button on the button bar.     





  After activating the Hail list you may select Add (on the menu bar for the Hailing list itself) and you will activate the Add a record dialog.  There are 2 fields in this dialog to fill out for a Hail list record.  The name and the e-mail address.  There are also menu selections to edit and delete Hail list entries.  





  To actually use the Hailing list (after you have some people entered) click once on the Hail button on the button bar.  From the resulting dialog you can select one of the entries and select Hail now on the menu bar to actually send a Hailing message (assuming you are logged onto the internet).  You can also add, edit, or delete records just prior to sending the Hailing message.  A maximum of 100 records can be stored in the Hailing list.





  Before you send the hailing message you can also write, if desired, a small note in the entry field below the list box.  This note could be used for several things, including telling the person you are hailing just how long you will wait for a possible connect.  The person receiving the hail will see the message in the dialog that notifies them that they are being hailed.  There are three buttons at the bottom of the dialog box to put three different "pre-canned" editable message stems into the entry field area.





  It is possible to send yourself a hailing message.  This can be a useful thing to test and see if your internet account settings in SecureCom will work correctly.  Just add a record with your own name and e-mail address to the list.  Log onto the internet and click the Hail button on the button bar and select yourself.  Press ENTER or double click on the actually entry.





  After pressing ENTER you will be notified as to whether it was successfully sent or not in a few seconds.





  If it was not sent correctly then you may have to double check your Internet acct. settings.  It could also mean that your internet provider may be using an alias domain name.  You may have to check with your provider or do a little investigation to figure out the settings that will work for you.  In particular the SMTP server setting for sending Hailing messages.





  If, however, the message was sent OK then click once on the Monitor ON/OFF button on the button bar to put SecureCom in monitor ON mode (red).





  Then just wait for a short while.  SecureCom should check your mail account and find the Hailing message, delete it and disturb nothing else there, and then notify you with  a dialog box asking you to either connect with the person hailing or to decline.  If this works appropriately decline to connect.  No sense trying to connect with yourself!





  if it doesn't work then check your e-mail address setting for receiving Hailing messages in the Internet acct. settings dialog.  If you believe you have it entered correctly but it still doesn't work then you may have the same problem that is mentioned above with your internet provider using aliases for their domain name or their mail server.





  Even if the hailing functions failed it is still likely that you can connect with other SecureCom users by exchanging your current IP address and using the Manual Connect function (accessed by menu under File).








Direct Hailing 





How it works ... 





   Direct Hailing with SecureCom is different than the "regular" (e-mail based) Hailing feature.  It was primarily added to make SecureCom work easier on the local network (Lan).  However, due to some other factors it has become very handy on the internet as well.





  Direct Hailing does not incorporate the use of e-mail.  Instead, whenever you enable Direct Hail monitoring SecureCom starts a little TCP based mini-server.  it's sole purpose is to sit and wait for connections on it's assigned port at it's current IP address.





  You can activate the Direct Hail monitoring in one of two ways.  You can open the Misc. settings page (under Configure on the main menu bar) and set the appropriate choices there or you can use the status bar and "hot keys" to start it.  Read the section below for more details on Direct Hail monitoring. 





  Whenever you send a Direct Hail SecureCom doesn't send an e-mail message with your current IP attached like the other Hailing feature in this program.  Instead, it directly attempts to make a connection with one of the SecureCom TCP mini-servers at the address you gave to it.   





  If your Direct Hail connects to a SecureCom mini-server then the mini-server asks the user if they want to connect the two copies of SecureCom for a chat session.





How to use it ... 





  There are 2 ways to make a Direct Hail.  





1.  Add an entry in the Hail list for someone you want to Direct Hail on the lan and in the Name field make the FIRST character an asterisks (*).  Then put the person's name after the asterisks (*John Doe, eg.).  This will tell SecureCom that this entry will Hail someone directly on the local network (Lan).  In the e-mail address field type in the persons IP address.  If  you want to Direct Hail someone on the Internet then add an entry to the Hail list and make the first character in the Name field a pound sign (#).  That will tell the program that it is an internet Hail (#Jim Doe, eg.).  Then type in their IP address in the e-mail address field.





2.  You can also do a Direct Hail without having to add an entry to the Hail list.  Just hold down on the CTRL key and click the Hail button on the button bar once.  Instead of seeing the regular Hail list you will see a Direct Hail dialog where you simply type in an IP address and press the Hail button to send it.





  After the Direct Hail is sent SecureCom should notify you in a few seconds that it was sent.  Sometimes it may take several seconds and sometimes it is immediate.





  Often, but not always (and I have NO idea why ..... ask the makers of TCP/IP) SecureCom will ALSO notify you 5-10 seconds (or longer) if the person did NOT get the Direct Hail.  On the internet the notification is not always reliable and can be real slow but on a local network the notification seems very reliable and usually within 5-8 seconds.





  However, after sending a Direct Hail, and you don't get a connection with your desired party in about one minute you can be pretty sure that they either were NOT monitoring for Direct Hail, were not on the internet, or just did not want to talk at that time.





  Since Direct Hailing is roughly analogous to "yelling for someone" it does NOT leave a record that you had been Hailing for them.  To many users it may seem a little more mysterious than e-mail based hailing and not as preferable to use on the internet since you must know the person's IP address ahead of time to use it.





  However, even on the internet, is has become more useful because of the advent of Cable Modem services which often provide permanent IP addresses and at least one or more services that provide the ability to have quasi-permanent IP addresses for people with dialup accounts.





Get your own static IP address ... 





  One such service (FREE) is Monolith Services.  They provide a service and links to utilities that make it possible for people with dialup internet accounts to maintain a static address on the net.  This makes using Direct Hailing on the internet a viable alternative.  For more details on how you can obtain a quasi-permanent IP address see the section on Monolith Services.





Monolith Services 





  Monolith Services has several different projects and free services available and it may be well worth your time to take a look at their web site and links at : http://www.ml.org/ 





  To obtain a free permanent IP address (hostname) go to their site and then go to the DynSite Site project and follow their on line procedure to sign up. 





  They are currently updating their web pages and you may have to do a little hunting to figure it out.  Previously, it was very confusing and not all that easy to figure out how to complete the process.  Hopefully, their updating will make it much less confusing.





   They also have links available to platform specific utility programs that will update your hostname every time you log onto the internet.  There are several such programs available for Windows 95/NT, Windows, and other platforms.





   Once you get assigned a hostname you can give the hostname to anyone to contact you directly on the internet with a variety of internet programs including SecureCom.  However, you always have to update your hostname every time you log on for the hostname address to be valid (using the utility program(s) available).








Direct Hail monitoring ...





  You can activate Direct Hail monitoring by opening the Misc. Settings page (under Configure on the main menu bar) and checking the "Enable TCP/IP Direct Hail monitoring" checkbox.  Then you can select whether you want it to monitor your local network address or your internet address.





  If you select the local network the text in the status bar will turn to a RED color.  If you select the internet the text will turn blue.  Regardless whether you check the internet or not --- if you are NOT logged onto the net it will default to the local network address (even though the color may not change to reflect it).





  The Direct Hail monitoring can ALSO be activated and set by using the status bar and two "hot keys".  To activate Direct Hail monitoring you can hold down on the CTRL key and double-click on the status bar once with mouse button 1.





  Each subsequent time you hold down on the CTRL key and double-click on the status bar will TOGGLE it back and forth from monitoring the local network (RED) to monitoring the internet (BLUE).





  Holding down on the SHIFT key and clicking the mouse button 1 on the status bar will shut the Direct Hail monitor off (BLACK).





  This accomplishes the same thing that you can do on the settings page - except for setting the monitors port number.





  The port, 8893, should NOT be changed unless it has to be.  That setting was added only for those people who MIGHT have something else using the default 8893 port.





  Also. only ONE running session of SecureCom can monitor for Direct Hails on the same address at the same time.





Give me a Hail sometime ...





  Feel free to Hail me sometime at my Monolith provided address :  hkypuck.dyn.ml.org





  Often (but not always) I do monitor for SecureCom Hails between 00:30 and 06:30 E.S.D.S.T.  (I work in the middle of the night)





  Just start SecureCom, hold down on the CTRL key while you click once with mouse button 1 on the Hail button on the button bar.  Then type in the address :  hkypuck.dyn.ml.org  and then Hail me.  I will answer if I am listening.





  Of course, you can always Hail me at my e-mail address too with an e-mail based Hail message.








Hailing List & Hail Log





  Hailing List --  This is a small database to enter and keep a list of e-mail addresses for the people you regularly want to connect with.  The Hailing list can be accessed from the menu bar under the Misc. menu item or on the button bar.  There are 2 fields to fill out for a Hail list entry.  The name and the e-mail address.  To use the Hailing list (after you have some people entered) click once on the Hail button on the button bar.  From the resulting dialog you can select one of the entries and then select Hail now on the menu bar to actually send it (assuming you are logged onto the internet).  You can also add, edit, or delete records just prior to sending the Hailing message.  A maximum of 100 records can be stored in the Hailing list.  To send Direct Hail messages always make the first character in the name field either an asterisk (*) or a pound sign (#).  Putting an asterisk as the first character in the field (*John Doe, eg.) tells SecureCom that this is a Direct Hail via the local network.  If you put a pound sign as the first character (#John doe, eg.) it tells SecureCom that it is a Direct Hail via the internet.  In the e-mail address field for a Direct Hail you would enter an IP address instead of an e-mail address.





  Hail Log -- This log keeps a rotating list of the last 100 Hailing messages you received -- whether you connected with them or not.  The Hail log dialog (accessed under the Misc. menu item) can be used to connect to some one also -- if the hailing log entry is not so old that the person hasn't logged off the internet and if they are still at the same IP address.  This can be useful if you get a Hailing message and don't want to connect at that exact moment but do want to connect in a few minutes.  Just reject the prompt to connect and use the Hail log to connect when you are ready.  it is also useful if you want to disconnect temporarily with someone and reconnect without having to send another hailing message (applicable, of course, if neither of you have changed your IP address and both are back in Listen ON mode).








Connecting with Manual connect ...





  Manual connect ... is the manual way of connecting to another SecureCom user.  it is accessed by selecting File from the main menu bar and the selecting Manual connect.  It can also be accessed by the popup menu for the lower entry field area on the main screen.





  The only prerequisites to using this function are that you already have the other person's current IP address and they are running SecureCom in Listen ON mode (on the same receive and transmit ports you are using).





  At the manual connect dialog just enter the IP address for the person you want to contact and press the connect button to start the connect process.





  This can be useful when you are already talking to someone and you want to disconnect for some reason but also want to call them back shortly.  Just disconnect - but before you do so just tell your current contact to put SecureCom back in Listen ON mode after disconnect.  Then, when you are ready to get back in contact with him (or her), just use Manual connect and put his (or her) address in and press connect.  In a few seconds you are connected again - without having to do another Hail (though there is no problem with doing another Hail, either).








File transfers





  SecureCom can also transfer files.  To transfer a file while connected simply select the File menu item and then select "Send file".





  You will see a standard "File open" type dialog box where you can select a file to be sent.  Select one and Press Send File.





  SecureCom will prompt the person at the other end by enabling the "Incoming file" button on the Button bar and by flashing and beeping them.  At the same time (and until they make a decision on the transfer) you will see a Waiting for a file transfer decision ... notice in the titlebar.





  The person on the receiving end then presses the button and either accepts or rejects the file transfer.  They are presented with a "File open" type dialog, to deal with at this time.





  The status of the file transfer is noted in the title bar whether accepted or rejected.  Be a little patient as the process is negotiated to begin the transfer.  Both users are shown the progress and the completion of the download in the titlebar.





  File transfers can be aborted almost any time during the process.  Select the File menu item and then select Abort file transfer.  This menu item is normally grayed out EXCEPT during a file transfer.





  File transfers can also be initiated by simply dragging and dropping a file on the bottom entry area while you are connected with someone.








Drag & drop, popup menus, font/color support, and more





  This version of SecureCom has very limited support for drag & drop, popup menus, and font & color support.





  Drag and drop support is limited to the SecureCom's main screen.





  The main screen area has only Drop support.  This support allows dropping any single file on it for a file transfer.  It is just an alternative way to start a file transfer as opposed to using the menu item to start the operation.





  Popup menus are supported on the main screen entry field areas.





  The popup for the top area is limited to Copy, Clear, and Save to file.  





  The bottom white area's popup has menu selections for nine different items - all of which are found in the File menu or the Edit menu on the titlebar.  





  These popups are added for user convenience and do not have any added function that is not already included in other menu items.





  Limited font and color support is available only on the SecureCom main screen in the two entry field areas.  Fonts and colors can be changed by selecting Configure on the main menu bar and then selecting Fonts and Colors on the sub menu.  This opens yet another sub menu with choices for setting fonts and/or colors on both the top (remote) or bottom (local) text areas.








Favorite Phrases





  Phrases (accessed under the Misc. menu item) gives you a sizeable windowed list box to keep up to 100 favorite phrases in for quick "no typing" access.  Each phrase can be up to 500 characters long.





  The Phrase window has menu bar selections to allow Adding, editing, and deleting Phrases.





  When you Add a phrase, Up to the first 80 characters will actually show in the list box list but all of it will be saved to a record.





  While connected, and running the Phrases window just double-click on a phrase and it will be automatically sent.  (or select and Press ENTER) 








Statusbar and titlebar 





  The SecureCom titlebar is used as an extra statusbar - even though it also has a statusbar at the bottom.





  The primary use for the titlebar is to display the name and IP address of the person you are currently connected to.  At connect time it will display that information.





  The results of an Echo test (on the button bar) are also displayed in the titlebar.





  Various error messages may also be displayed there.





  The statusbar at the bottom of the main SecureCom window is primarily used to display your Listen ON status,  port and address information, e-mail Monitor ON/OFF status, Direct Hail monitoring status, and a few other minor messages. 





  It will also display the status of file transfers in terms of percentage completed and announce their completion.





  And lastly, it can be used to CHANGE your Direct Hail monitoring status by using several hot keys.





  For details on using the status bar to change Direct Hail monitoring see the section on Direct Hailing.








Other misc. features





  Copy & Paste, Clear, and Word Wrap -- The Edit menu item has sub-menu's supporting copy and pasting.  The Copy remote menuitem copies all the text in the remote entry area (upper) to the system clipboard.  The Paste Local menu item pastes anything that is in the system clipboard (text) into the local entry area (bottom).  There are also menu items to clear each area and to toggle the Word Wrap state for either.





  Misc. File menu items -- Under the File menu is also an item that put you in Listen ON mode and one to disconnect you.  This mimics the exact same function that is accomplished by clicking on the Listen ON/OFF button the button bar.  The Manual Connect menu item is described in the Quick Start section.  The Wake Up menu item is a function that, while connected, you can select and beep the guy on the other end 3 times to literally get their attention.  The Current IP address menu item will bring up a dialog box that will display your current IP address.





  Button Bar -- The Listen ON/OFF button is toggable.  Select it once and it will go to Listen ON state.  In this state SecureCom is actually monitoring the port (6667 or whatever you have set it on) for any connection attempts at your specific IP address.  You must be in listening mode for someone to be able to connect to you.  If you aren't listening -- they can NOT connect to you.  However, you do NOT have to be in Listen ON mode for YOU to initiate a Connect.  When you send a Hailing message SecureCom automatically puts itself into Listening ON mode and when you actually connect, the Listen ON mode (Yellow) changes to Connected! mode (Red).  When this button is in Connected! mode you can also press it once again to terminate the connection and it will toggle back to Listen OFF mode.





  The Echo button is simply a button to test the connection.  At any time while connected just press the Echo button and if the connection is OK you will get one beep and a message flashed in the titlebar.  This message has made a round trip from your machine to the other and back.  It is also useful to see how fast the connection is.  If the connection is broken -- nothing happens.  Be patient, though.  A slow connection might take several seconds for the message to go there and back.  (The echo is only heard on the end that originates it.  The other person is not aware that they have been echoed)





  The Incoming File button is normally grayed out and only comes to life when someone tries to send you a file.  It will beep and flash to let you know.  Select it and then decide to accept or reject the incoming file transfer request.  Sending a file is accomplished through the Send File menu item under the File menu item or by dragging and dropping a file (only one file at a time) directly on the bottom entry area.





  The Monitor ON/OFF button toggles back and forth to turn the monitoring on and off for checking your mail box for Hailing messages.





  The Hail button is pressed to initiate calling (Hailing) someone.  It pops up a window with a list box of your Hailing list entries.  To add, edit, or delete Hailing list entries click on the desired menu item on the menu bar.  Double clicking on an entry in the dialog box or selecting Hail now on the menu bar will send the Hailing message.  Also, the Hail button can be used to send Direct Hail messages without using the Hail list by holding down on the CTRL key when you click on the Hail button.  When you do this you will activate the Direct Hail dialog instead of the Hail list dialog. 








Command line arguments 





  SecureCom has several command line arguments : 





1.  -XX   This command line argument will make SecureCom check to see if there are any other versions or instances running.  If it detects any other SecureComs it won't start.  This parameter MUST be used as a FIRST parameter if it is used at all (unless it is added on the end of -L, -M, or -MC as discussed below).





2.  -NI   This parameter allows SecureCom to set the Name for the SecureCom .INI file.  The default name is SecureCom.INI.  If you use this parameter you can set the .INI file to any file name or fully qualified file name that is legal.  Leave NO space between the -NI and the name of the .INI file 





example :  SecureCom -NIMYNEW.INI





example : SecureCom -NIC:\UTILS\NC.INI





3.  -L   The -L argument will cause SecureCom to start in Listen ON mode.  This means that when SecureCom first starts it will immediately start monitoring your current port assignment (as set in the port settings) for the receive port.  The Listen ON button will be yellow.





4.  -M   The -M argument will cause SecureCom to start in Monitor ON mode.  This means that when SecureCom first starts it will immediately start monitoring your mail account for Hailing messages.





5.  -MC   This will cause SecureCom to start and immediately prompt you with the Manual Connect dialog.  You can choose to cancel or to connect.  





6.  -HN   This command line parameter with the IP address, receive port, send port, file transfer port, and separators added will start SecureCom and attempt to connect to another copy of SecureCom at those parameters.  For example, if you wanted SecureCom to start and attempt a connection immediately at 9.96.56.288 with receive port 6667, send port 6667, and file transfer port 21 you would use this : 


-HN9.96.56.288@6667@6667@21


The separator is the @ character and there are NO spaces 


** Send and Receive ports must be the same.  SecureCom actually just supports ONE socket port for communication now but the command line parameters for send and receive were left this way for backward compatibility issues.





7.  -LRN   This command line parameter will force SecureCom to start in Listen ON mode on the internet address (if connected)





8.  -LNN   This command line parameter will force SecureCom to start in Listen ON mode on the local network address (if a network address exists).





  The -HN parameter has to be used as the FIRST and ONLY parameter if it is used at all.  It was added to make it possible for users to write macros or REXX scripts for their e-mail clients to parse out Hail messages and start SecureCom to handle them. 





  An XX  can be added onto the -L, -M, or the -MC parameters, eg. -LXX, -MXX, -MCXX.  This will make any of these three parameters add on the behavior of the -XX parameter in addition to their own behavior.





  These command line arguments are included mostly to allow the ability to interface third party mail programs like MR2i, PMMail, Post Road Mailer, and others with SecureCom.





  This makes SecureCom even more flexible as it allows not only SecureCom itself and/or MailRun to monitor and notify of incoming Hailing messages but also allows many third party mail programs to do so too.








Running multiple sessions





  Running multiple sessions of SecureCom is supported in 2 different ways.  The first way is to run totally separate copies of the program in different folders.





  Since SecureCom does not take up numerous megabytes of space this is a viable solution to those who may want to run multiple concurrent sessions.





  To do so it is fairly easy to just drag the whole folder that has the SecureCom program in it and copy it to another folder or subfolder and then set it up for use on another set of ports.  





  The second method for running multiple sessions is probably a better solution for most users.  Simply use the SecureCom command line switch -NI (as discussed in the Command line arguments sections) to define a new .INI file for program object that references the actual SecureCom executable file.





  For example - put 2 shortcuts on the Desktop for SecureCom.exe.  Name one NC1 and the other NC2.  Bring up the popup settings for NC1 and select Settings.  On the shortcut tab in the target field use the -NI argument to point SecureCom to a NEW .INI file.  Just add the parameter right after the text already in there (add a space first).





  Example : -NINC1.INI





  Then do the same for the NC2 program object but use -NINC2.INI in that target field.





  Now that both of the shortcuts are set up to use separate .INI files, just start the respective program objects and set each instance up by filling out it's own settings.





  To actually RUN concurrent sessions in Listen ON mode it is necessary to set the the copies of SecureCom on a different port.  When SecureCom is in listen ON mode, it is bound to that specific address and port and no other session can bind to it until it turns it loose.





  However, as soon as you CONNECT to someone SecureCom releases that port - because it is no longer listening for more connections.  Then you could start another session and put it in Listen ON mode if desired.





  Note :  Whenever you Hail someone, SecureCom put's itself into Listen ON mode to await a connection attempt.  If you ALREADY have another session listening then this would fail - unless it was listening on another port.  If you have another session that is ALREADY connected however (and therefore not in Listen ON mode) you can Hail someone else without any problems.








Talking to more than one person at a time .....





  Besides creating and starting multiple sessions yourself, as discussed in the Running multiple sessions section, SecureCom will also automatically spawn new sessions under certain circumstances.


  If you are currently connected to someone and engaged in a chat and someone Hails you then you can just accept the Hail in a normal fashion and press the Connect button on the Hail dialog.  When you do so, SecureCom will spawn a new session and connect with that Hail.


  You will then have 2 totally separate concurrent sessions running.  You can carry on BOTH conversations if that suits you or you can just chat long enough with the new person to tell them to call you back later.  This way, SecureCom ensures that you never miss a call.


  Also, if you are currently connected and chatting you can hail someone else, if desired, with the same copy of SecureCom you are already using.


  When you do, SecureCom will just start a new session (in Listen ON mode) that will await a possible connection with the person you just hailed.


  Currently SecureCom does NOT support multi-party or group chat - meaning you can't have more than one person chatting to you on the same running copy of SecureCom.  SecureCom will probably have group chat capability added on later this year in the next major version release or possibly as a separate version.  It hasn't been decided yet for certain just how that will be done.




















PGP support ...





  PGP support in SecureCom is supplied in the form of working with PGP 2.6x (and perhaps other 2.x versions) as a plug-in.  SecureCom, itself does NOT contain ANY encryption code and never will.





  This section is also NOT intended as a tutorial on how to use PGP encryption nor do I claim to be an expert in the use of PGP.  It is, instead, a section to help facilitate setting PGP 2.6x up to work with SecureCom to afford an extra layer of security and privacy that some people desire.





  SecureCom has only been tested with PGP 2.6x for DOS.





  Below are two sections on how to minimally set up PGP for use with SecureCom and how to plug it in.





Setting up PGP 





1.  Obtain a copy of PGP 2.6x. for DOS.  





2.  Unzip it into a directory of it's own.





3.  You then need to add 3 lines to your to your Autoexec.bat file which is usually in the root directory of your boot drive. 





4.  Add :  SET PGPPATH=X:\PGP26





5.  Add :  SET PATH=X:\PGP26;%PATH%





6.  Add :  SET TZ=EST5EDT





7.  The path's used in YOUR installation of course should be where you installed PGP and not the example lines above.  The timezone should be YOUR timezone.  





8.  Reboot your computer.





9.  Then open a command line session and go to your PGP directory.





10.  Type : pgp -kg  (then press ENTER) 





11.  This starts the procedure to generate your PGP key files.  Follow the instructions on the screen.





12.  Select RSA key size - strongly recommended to use 512 bits 





13.  Enter a user ID for your public key ring - suggested that you use something like :  John Q. Doe <jd@myisp.com>  (with your name and address, of course)  





14.  Then enter a pass phrase ..... be sure to write it down and don't lose it.  You'll be asked to type it in twice to confirm it.





15.  Then the program will ask you to hit keys at random.  Do so ..... until it tells you that it is finished.





16.  You will note that it has generated 2 files :  secring.pgp and pubring.pgp.





17.  I suggest you back up a copy of these before you proceed.





  


  Now that you have a set of PGP key files and I assume the person you want to talk to has done the same ... here is how it works.





  Make a copy of your "virgin" public key ring file - pubring.pgp and rename it to something a bit more unique - perhaps your initials or first name .... jqdoe.pgp, eg.  





  Keep the .pgp extension the same, though.





  You can NOW send that file to the OTHER person you want to chat with that has SecureCom.





  Meanwhile, they have gone through the same procedure and will send you a renamed copy of THEIR pubring.pgp file.





  When you get a copy of THEIR pubring.pgp key file then copy it into the same directory with your PGP files.  If they did NOT rename it to something else THEN you do that now (otherwise you would replace your own pubring.pgp file that is already there and you don't want to do that).





  Then, after you have their pubring file in your directory, go to a command line session again and go to your PGP directory and do the following (mybuddy.pgp is the file your friend sent to you):





1.  Type :  pgp -ka mybuddy.pgp  (press ENTER)





2.  When it asks if you want to certify any of the keys answer YES.





3.  When it prompts you again and asks if you want to certify it yourself answer YES.





4.  At the next prompt (Are you absolutely certain .... blah blah blah) answer YES.





5.  At the next prompt enter YOUR pass phrase (the one you used in step 8 above).





6.  At the next prompt I usually make selection number 4 ..... use your own judgement.





7.  That's it ..... that person is now set up for you to use PGP with.





  It is assumed in the next section that the OTHER person (the one you sent your pubring file to) has gone through the same preceding procedure.  Now you (and he/she) can plug it into SecureCom by doing the following : 





1.  Start SecureCom.





2.  Select Configure on the main menu bar.





3.  Then select PGP settings.





4.  In the PGP support settings dialog select the first checkbox at the top - "Enable PGP encryption support".  That will enable and un-gray the other choices on the page.





5.  Type in the fully qualified PGP executable file name in the first entry area (x:\pgp26\pgp.exe, eg.)





6.  In the second entry area type in your pass phrase.





7.  In the last entry area type in the OTHER person's user ID.  If you have forgotten it already from when you certified their key, then go to the command line in the PGP directory and type :  pgp -kv  (press ENTER).  You will be able to view a list of everyone in your pubring file.





8.  Now, deselect the "Enable PGP encryption support" checkbox at the top (for now) and press the Save button at the bottom.





9.  That's it!





  Incidentally, the "Enable ..." checkbox on the PGP settings page enables and disables the SENDING of encrypted messages.  It does NOT enable/disable the receiving of encrypted messages.  That will be explained in a moment.





  Now, assuming that the other party has also set up their SecureCom and PGP you are ready to test it.





  Hail them and establish a connection first with PGP disabled.





  After a good connection is established open up the PGP settings and enable it.





  Type in a short message and press ENTER.  You should notice some disk activity and possibly even a short delay.  PGP does slow down the operation and add some overhead.





  You may also notice that WHEN you send or RECEIVE an encrypted message that it will be noted in the statusbar briefly. 





  Check with the other party and see if they got your message OK.  Even though they did NOT enable their PGP yet, SecureCom always recognizes an incoming PGP message and ATTEMPTS to use your PGP and information entered to decode it.  





  Assuming all went well and they got the message OK and it looked normal then have them enable their PGP and test it by sending you an encrypted message.





  If all that went well, then that is really all there is to it.  Either of you can enable or disable PGP at any time.  If you enable it again and send a message it will always be detected and decoded at the other end automatically - whether they have their PGP enabled or not.  The PGP enable checkbox only enables/disables sending of encrypted messages.





  If you have MORE than one person that you want to talk to using PGP encryption then also exchange public key rings with them AND add them to your public ring by using the pgp -ka method described above.  I suggest that you usually just send other people a copy of your "virgin" pubring.pgp file (renamed) that you saved when you first created it.  However, if you are an accomplished or expert user of PGP you may want to do otherwise since you understand the security considerations.





  Whenever you talk to someone different all you will have to do (assuming you have exchanged keys, added them to your ring, etc.) is to open up the PGP settings and change the last entry field by typing in THEIR user ID.  The rest of the settings should never need to be changed.





  When you type in a user ID you do NOT have to always type in the whole ID.  If you only have one person or just a few added to your public ring and their names and addresses are not similar you could just type in PART of the user ID and PGP will most likely match it up and find the right key.





But the darn thing didn't work!





  Setting up PGP is not the easiest thing in the world to do.  It's easier than running a marathon but not as easy as drinking a beer.





  If you think you have followed all the instructions and you still can't get it to work then you may need to read the PGP documentation and spend a little more in-depth time studying it.





  You can also open the PGP settings in SecureCom and check the "Create log file for PGP DOS sessions" checkbox.  This will generate a file with the output of the last DOS session in it (in the same folder where the SecureCom executable is located).  





  This may help to figure out just what is going on because you will be able to see the error messages, if any, that are issued by the PGP program.





  Before you report ANY problems to me make sure you are running PGP 2.6x.  It will NOT work with some of the latest versions that have thoughtfully changed command line switches and dropped some important switches.  I guess they figure that programmers don't have anything else to do but rewrite their software every month for a new version of PGP .....




















What's New In SecureCom!





SecureCom ver. 1.00W  (4-20-98)





SecureCom replaces NetChat (not backward compatible, however)





1.  Major reworking of the internal code.





2.  Single socket now used for chat connection.





3.  Faster connecting and more reliable in maintaining connections.





4.  More reliable file transfers.





5.  Direct Hailing feature added to make it work better on Lan networks and with people with known IP addresses on the internet.





6.  SecureCom will now spawn a NEW session if you accept a Hail (connection) while you are already connected in a session.





7.  SecureCom will now spawn a NEW session (and wait for a connection) if you Hail someone while you are currently connected in a session.





8.  Once a session is started SecureCom no longer hogs the port it was listening to.  This allows running an almost limitless number of sessions without worrying about changing ports.





9.  SecureCom now supports running separate sessions from the SAME executable.  It is no longer necessary to set up multiple physical copies - though you can set up multiple .INI files for the SAME executable if desired.





10.  SecureCom now has plug-in support for PGP encryption (tested with 2.6x for Windows 95/NT and DOS).





11.  SecureCom now has an elapsed time indicator so you can keep track of how long you are connected.





12.  Improved reporting of status of the connection in both the titlebar and a status bar.





NetChat ver. 1.36  (12-01-97)





1.  Small bug fix to NetChat's hailing function to make it slightly more robust and able to handle more SMTP servers.





NetChat ver. 1.3  (10-27-97)





1.  New Registration method -- NetChat has a NEW registration method.  The original code word that registered NetChat will NOT work with this OR future versions.  To register this version you will require 2 Key files : main.key and guest.key





2.  Auto-Identification on connect -- When you connect with someone now (unless they are running an earlier version before this feature was implemented) you will be notified in the upper entry area as to whose "Key" you are connecting to AND which key it is (guest.key or main.key).  The name of the registered person for that Key will be displayed.  If a person is NOT registered then a message to that effect will be displayed.  If the person is running an older version before this feature was implemented then NO message will automatically displayed.





3.  New Hail dialog for sending Hails -- There is a new dialog box for sending Hail messages.  The  top part of the dialog is still the same as before with a list box where the names of the person you want to Hail will be listed.  The bottom part is NOW an entry field where you can type a short note to the person you are Hailing.  The note can be up to 350 characters long.  This note can be used for a variety of purposes including, but not exclusively, to let the other person know just how long you might wait around for them to answer your hail and connect.  There are also 3 pushbuttons at the bottom of the page to automatically generate 3 preset messages that can be edited or modified.





4.  New Hail dialog for incoming Hails -- The dialog box that you see WHEN you get Hailed has been changed also.  It also has an entry field (read-only) below the list box of Hails that shows the selected Hail's message (if one was sent with it).  In addition the fields below it now show the ports used by the person who hailed you in addition to their current IP address.  There is also a checkbox that can be checked or unchecked to turn the Auto- sync ports feature OFF or ON for that particular Hail.  This check box was primarily put there for RARE occasions and for diagnostic purposes.  It is NOT likely it should or would be used by most users on a regular basis.





5.  New Hail Log dialog -- The Hail log dialog box has been changed to MATCH the incoming Hail dialog box.





6.  Remote Party info -- This feature will allow you to query a person AFTER you have connected and to see what version they are currently running.  If you query someone running versions 1.00 - 1.03, though no information will be returned.  When you are connected and  select this feature you may have to wait a few seconds before the dialog box with the Remote party info appears.  This feature reports three items.  The port setting the remote party has for transferring files, their current IP address, and what version of NetChat they are using.





7.  Running Multiple Instances of NetChat -- Earlier versions of NetChat could NOT run multiple instances off of the same executable file.  This version can - due to the addition of a command line parameter added to it that allows setting which .INI file the program instance will use.  For details see :  Running Multiple Instances and Command line arguments 





8.  Command line arguments -- NetChat now has several command line arguments that can be used for several reasons.  For detail see : Command line arguments 





9.  Auto-synchronize ports from a hail message -- This makes it easier to connect when someone hails you.  There is a NEW format for Hail messages and they now include your port settings AT THE TIME you hail someone.  So .... if you receive a hail (from someone with this new version) AND you have this feature enabled you do NOT have to worry what ports they have their NetChat set on.  Your copy will read the Hail message and synchronize your ports to match theirs to help insure a good fast connect.





10.  Port Reset Button -- A button that enables you to reset NetChat quickly to the user selected (on the Misc. Settings ... page ) port settings without having to type them in.





11.  Start NetChat Minimized -- Just like it sounds -- enables NetChat to start in a minimized state.





12.  Current IP address -- A menu item that will present you with a dialog box showing your current IP address.





13.  New Internet Acct. Settings -- Settings changed.  Now, instead of entering the Domain name and the user name, you enter the Pop server/SMTP server and your e-mail address.





14.  OS/2 sendmail.exe support -- There is now a check box that, if checked, will force NetChat to use the Windows 95/NT sendmail program (sendmail.exe) instead of it's own internal TCP/IP code to send a Hail message if desired.  If you have had trouble making NetChat sending Hailing messages then this may work better for you.





15.  Numerous internal code changes --  Many internal code changes to make NetChat more solid and reliable.  





16.  New menu item -- Hailing list, Hail log, and Phrases are now consolidated under the Misc. menu item on the main menu bar.





17.  Also .....  New license agreement AND a "sister" version for Windows 95 -- See details :  New license agreement 




















NetChat users 





  SecureCom is a FREE upgrade to any registered NetChat user.  Your main.key and guest.key files will still BOTH work with SecureCom.  If you like, though, you may contact me via e-mail and request a NEW and separate main.key file to replace your current guest.key file. 





   Since SecureCom has lowered the price from $25.00 to $15.00 and done away with issuing any NEW guest.key files I feel it is only right to offer current NetChat owners the chance to have 2 complete and separate licenses (and thus 2 main.key files) if they so desire.





  So, if you want a second main.key file to replace your current guest.key file just write me and request it.  Also be SURE to tell me what NAME you want it to register with - it does not have to be your own name since it is a separate license.




















America On Line ...





  SecureCom for Windows 95/NT will work with AOL (America On Line) 3.x software with a few notable exceptions.  AOL apparently will not allow direct access to their mail server by any client software other than their own proprietary mail program.  This means that AOL users can't use the e-mail based Hail message facility built into SecureCom.





  Also, SecureCom for Windows 95/NT only works with AOL 3.x software on Windows 95.  It does not work at all on Windows NT with AOL 3.x software.





  SecureCom can use Direct Hailing an/or manual connect while connected to AOL, however.  It works quite well with the latest 3.x AOL supplied software which seems to now support a real internet connection (as opposed to earlier versions of their software which kept almost ALL internet based software from working).





  So, other than being able to use SecureCom's built in e-mail based Hail messages, SecureCom for Windows 95/NT version will otherwise work normally on Windows 95 with AOL (3.x).





  As of this writing their 4.x software is in beta but has not been tested yet.  It is assumed that things can ONLY get better.





  Be sure to read the section on Direct Hailing for details on how to use that feature.





  AOL users can STILL, however send or receive e-mail based Hail messages, albeit not as handily as the rest of us, by doing it through the AOL e-mail facility instead of having SecureCom do it.





  When you want to send a Hail message to someone do the following : 





1.  Compose a letter using the AOL e-mail facility 





2.  Address it to the person you want to Hail 





3.  In the Subject entry box type in or paste : &&$~SECURECMSG~$&&888.88.88.888





4.  Instead of the 888.88.88.888 put in YOUR current IP address - which can be obtained from SecureCom by selecting "Current IP address" from the File menu.





5.  In the body of the letter paste or type in these 2 lines : 


NC%Ports: R:6667 T:6667 F:21


NHC%Note: I'll listen for a connection for 10 minutes 





6.  The actual note part (anything after NHC%Note:), of course can be changed to suite you but it can only be on that one line and less than 300 characters.





7.  Then mail it!  Make sure SecureCom is running and press the Listen OFF button to put it in Listen ON mode.  Then it will monitor for any connection attempt.  SecureCom can be minimize if desired.  It will popup if and when you get a connection.





  When you get NEW mail at AOL and ONE of the e-mails is a Hail message do the following : 





1.  Look at the subject line of the message and highlight the IP address (anything after &&$~SECURECMSG~$&&) and the hold down on the CTRL key with one finger and press on the Insert key once with another to copy this into the system clipboard.





2.  Then start SecureCom and select File on the main menu bar.





3.  Then select Manual Connect 





4.  Put the mouse pointer into the entry field of the Manual Connect dialog and click it once to set the focus to it.  Then hold down on the SHIFT key with one finger and press the Insert key once to paste the contents of the clipboard (your IP address) into the field.





5.  Then click once on the Connect button.  That should connect you to the person who hailed if they are still listening.




















SecureCom support 





  SecureCom is primarily supported by me through e-mail and/or a live prearranged SecureCom session with me.





  SecureCom support is not, I repeat, not supplied by BMT Micro.





  E-mail is probably the most reliable way of getting to me with a problem report.  Please send all the details you can if you send a report of a problem.  A "It ain't working dude!" report doesn't do either of us any good!  The devil is in the details .....





  It would be nice to know WHICH version of SecureCom you are using, what Operating System and it's version number that you use, any error messages you get from the program, and the particulars on what is happening.





  Send all e-mail to either grobin@iname.com or grobin@coax.net





  These mail boxes are usually read every day.





  E-mail can also be left at the MailTo link on my web page at http://www.coax.net/people/grobin





  Support for SecureCom is also available from Barry Adams and his SecureCom Support Page (The Official SecureCom Support page).  The address is http://cud.cow-net.com/badams/index.htm





  The web page includes a downloadable list of current users who would like to chat with other users, the latest version of SecureCom, the ability to add your own name and e-mail address to the SecureCom users list, hints on integrating MR2i with SecureCom, and other announcements and helpful ideas.




















Known bugs and limitations





  Like any software that does much SecureCom is not perfect.  Sometimes you may experience slight difficulties in connecting.  This may be because of problems with your provider and/or other internet difficulties.  It may also be because SecureCom has a lot going on under the hood.





  Please report any other bug and problems with all the possible details you can think of.





  However, it doesn't do any good to report a bug or a problem with the program if all you tell me is that it doesn't work.  If you truly expect any help or results you have to be willing to articulate and elaborate just what is or is not happening.  it also helps to know what your system consists of and what version of SecureCom you are using.  Less than that is a waste of my time and yours.




















A Special thank you!





  This program is an accumulation of a lot of work, sacrifice, and sweat.  Many man hours spent looking for solutions and lots of "grunt" work.





  And not all of it was done by me ...





  The beta testers who have helped and encouraged me, crabbed at me, groaned at my mistakes, and generally given me great ideas are partly responsible for this program being released before the 23 century.





  In particular four of them have been almost indispensable with their help.





  My good friend and tester Junior Thompson, whose machine I blow up regularly with experimental code is always a good source for ideas and has been an immense help in facilitating the setting up a local network here to do the testing necessary to finish this application.  When I have made 100 million dollars off this program and live near the Riviera I will occasionally send him scraps of my bread when I think of him.  Just kidding Junior!  Thanks again for the help.





  Matt Linder, a fellow Windows 95/NT enthusiast and programmer, has also been a source of help with several code related problems.  While his schedule is almost as bad as mine we have traded ideas and code via e-mail and the local Windows 95/NT S.I.G. meeting.  Thank you Matt for some of the ideas and code snippets.  Also ..... check out Matt's own web page for some of his programs at : http://www.geocities.com/SiliconValley/Park/8796/





  Lastly, are the two "wild and crazy guys" from Canada.  Barry Adams and Lawrence Lucier.  Barry and Lawrence are two really hip Windows 95/NT enthusiasts who have spent an enormous amount of time connected in SecureCom sessions testing and regularly blowing up new features!  Every time I thought I had coded something well Barry would just smile (electronically, of course) and crash the latest beta.  If it passed his test he handed it to Lawrence for the real test .....  Seriously, a big thank you to Barry and Lawrence for all their efforts and help!  




















Registering SecureCom 





SecureCom is shareware - software which is free to try, but it is expected that if you use it beyond a reasonable trial period (30 days), you will register it.  This version has complete functionality and is not crippled in any way.  it does have several irritating screens that bug and beep you at various times, though.  Registering the software will disable these "bug screens".  Your support allows further development of SecureCom and other projects for Windows 95/NT. 





o $15 - BMT Micro registration. Registration code and a key file will be supplied by me via e-mail or snail mail if desired.  Be sure to tell the BMT Micro folks to notify me when you register so I can send them to you in a timely manner.  Feel free to notify me, yourself, too.  See their order form (included with SecureCom) and/or visit their web site (www.bmtmicro.com) to see what forms of payment and shipping they provide.  This is the preferred way to order SecureCom.  (You can also buy 2 complete licenses at the same time for $25.00 - a savings of $5.00)  





o $20 - Direct registration.  Registration code and a key file will be returned via E-mail (or snail mail IF requested).  Send your check or money order (must be drawn on a US Bank), with some type of a return address, to Gary L. Robinson.  If you send an e-mail address PLEASE MAKE IT LEGIBLE.  I can't send the registration if I can't read the address or if the address is incorrect.  2 complete licenses can be purchased directly at the same time for $35.00 (a savings of $5.00).     





Registration for this version of SecureCom includes free upgrades to future versions of SecureCom up to but not including version 2.0.  Registering this version of SecureCom will automatically register you for all 1.x and 1.xx releases.  When version 2.0 of SecureCom arrives, you will need to re-register and pay an upgrade fee.  This registration does not necessarily include any free upgrades to the MailRun program.  




















Registration key file 





  This version and all future versions require you to have a Key file - main.key.





  When you register SecureCom at BMT Micro they are supposed to notify me and at that time I will send you via e-mail (or snail mail if preferred) a Key file.  





  It may help expedite things slightly, though, if you also notify me that you need one.





  The Key file will be set to accept your name - the name you registered with.  This name will also identify you when you connect with someone.





  When you connect, the other person will see the message : ***** Your Name has connected with you! *****





  Your Name will be the name of the person who registered the program.





  You will see at your end a similar message if the person is registered and if the other person is NOT registered it will note that as well.





  The main.key file must be kept in the SecureCom folder at all times to keep the program registered.




















Entering your registration code 





  This is not rocket science!





  The main.key file needs to be in your SecureCom folder at ALL times for the registration process to work and continue to work.





  If you are registered and did NOT receive a main.key Key file then contact me (NOT BMT Micro) for one.





  To register SecureCom, select the Help menu item on the main screen menu bar.





  Then select Register ...





  Enter your registration Code (it should be your name) and press Save.





  You are now registered and ALL the annoying dialogs and beeping will cease!  The UNREGISTERED notice in the main screen titlebar will be removed, also.





  Please keep your registration code (can you forget your own name?) and do not lose it.  You may need it again if you reinstall SecureCom or if you reinstall Windows 95/NT itself.





  If you lose your registration code and/or key file please contact me to get replacements.  Do NOT contact BMT Micro to replace any lost codes or files.




















Package Contents 





The files contained within the SecureCom archive are: 





1.  BMTORDER.DOC    6286 bytes 





2.  FILE_ID.DIZ     1547 bytes 





3.  SECOM.EXE      583168 bytes 





4.  ReadSC.DOC      148992 bytes 





5.  ORDERFRM.DOC     1892 bytes.





6.  READ1ST.TXT     3152 bytes.








  If all these files are not present when the archive is unzipped, please notify the sysop where you downloaded the archive from.




















License for SecureCom and MailRun





License And Rights Granted By License 





All registered users are granted one (1) license.  This license includes 1 key file - main.key





This requires the registered user to have the main.key file present in the same directory as SecureCom at all times to stay registered.  It also requires the registered party to type their name (exactly as registered ) in the registration entry field in the SecureCom program to complete the registration process.





This single license grants the registered party the right to use the main.key registration file with and be registered for SecureCom for Windows 95/NT, SecureCom for Win95, and MailRun for all 1.x versions up to, but not including, ver. 2.0 of any of these three programs.





The license does not grant the registered party the right to distribute the main.key to any other parties whatsoever.




















Disclaimer 





This package is provided "as is", without any guarantees or warranties whatsoever. The author is not liable or responsible for any loss or damage of any kind whatsoever, including, but not limited to, losses of a financial, physical, emotional, marital, social, or mental nature that may result from the use or the purported use of anything in this package, for any purpose whatsoever.

















Frequently asked questions ...





Q.  Why doesn't the program register properly when I type in my name in the registration dialog?





A.  Make sure you look your registration letter closely and be certain that you are typing in the name exactly as it is shown there.  It is case sensitive.  Also be sure to have your main.key file in the same folder (directory) where the program is located.  The key file has to be kept there at all times.











Q.  When I press the Monitor OFF button to toggle it into Monitor ON mode it immediately goes back to OFF.  What am I doing wrong?





A.  Monitor ON mode (Red) means that SecureCom will check your Pop mail server for Hail messages.  If the button won't stay on, it could be for several reasons.  





1.  You are not logged on to the internet.





2.  Your ISP's Pop mail server is not functioning.





3.  You have entered an incorrect setting on the Internet Acct. settings page for your Pop mail servers address.





Number 3 is the most common problem and is quite often caused by Pop mail servers that use multiple aliases.  Generally, SecureCom would use the same exact setting that you use in your regular e-mail program.  Sometimes you may have to experiment a bit or talk with your ISP, though, if they are using aliases for the servers real name or address.











Q.  When I try to monitor for Hail messages I get an error message saying that it can't find my host and the button won't stay RED?  What is happening?





A.  Your settings for the "Pop server" in the Internet acct. settings page is not appropriate.  It is either typed in wrong or your internet service provider may be using an alias for their Pop mail server.  Generally, this setting should be the same setting that you use for your regular e-mail program in it's Pop server setting.











Q.  When I try to send a Hail message I also get a similar error message saying it can't find my host?





A.  You have probably typed in the wrong or inappropriate setting for the "SMTP server" setting on the Internet acct. settings page.  This setting can SOMETIMES be the same as your Pop server setting but MAY be quite different.  It should be the same as the SMTP server setting that your regular e-mail program uses to send e-mail with.  If this doesn't help you may need to do a little investigative work and/or consult with your ISP.  Also .... on the Windows 95/NT version of SecureCom you can check the "Use Windows 95/NT's sendmail instead of SecureCom's" checkbox on the Internet Acct. settings page and try that.  Windows 95/NT's sendmail function might be able to work with your setting if SecureCom's own internal function fails.











Q.  When I try to put SecureCom in Listen ON mode the button fails to stay Yellow.  This also happens when I Hail someone ... and then we don't connect.  What's happening?





A.  The Listen ON mode allocates a Socket and binds it to a port on your computer.  Then SecureCom listens on that port waiting for a connection.  If it fails to bind to that port then it can not listen for a connection attempt.  This may happen if you have another program (or another copy of SecureCom) that is already using that port.  You can experiment and change the port settings (R:) and try a lower number than the default 6667 (ports can be set for any value from 1 to 9999) and see if this helps.  If this doesn't help then it may be that your TCP/IP is not quite configured correctly.  If changing the default port does help you may want to have the people you regularly talk to change their default port to be the same as yours.











Q.  What exactly happens when I Hail someone?





A.  Well, when you send a regular Hail (e-mail based) SecureCom queries your current IP address and composes an e-mail message with your name and IP address in the header.  It adds a small group of characters before the IP address that act like a code so that it can be recognized by SecureCom's Monitor mode.  Then it sends that message directly to the person's mail box who you want to talk to - just like any e-mail letter.  At the same time SecureCom activates your Listen button and it goes to listen ON mode (Yellow).  Now SecureCom is waiting to see if the other person will connect to you.











Q.  How do I know if the other person got my Hail and if they are going to connect?





A.  You don't know.  There is no way to tell with SecureCom.  Some programs like ICQ (and others) use a system where their program (when started) updates a 3rd party server and allows you to, in effect, know when someone is on line.  SecureCom does not do that and does not intend to support that.  SecureCom does not intend to be dependent on any other 3rd party servers other than the ones it has to use to make a direct connection.











Q.  Then after Hailing someone do I just wait around for a while to see if they answer?





A.  The general methodology for using SecureCom is different than that of "party line" apps like ICQ or Chat servers.  Most SecureCom users use the program to talk to a friend, relative, or someone they know well.  They often arrange, ahead of time, approximately when they will both be on the internet or know generally what the best time is to Hail someone.  Though, they also can Hail that person at any time and just minimize SecureCom and go on and do something else.  The person who got the Hail can answer it any time AND if you are still on and your IP hasn't changed then SecureCom will pop up and notify you that you are connected.











Q.  is there any way to tell when a Hail message was initially sent ..... when you get one?





A.  Yes.  There is a Date/Time stamp for the message on the lower half of the Hail notification dialog.  Also, when a person sends a Hail message they can attach a small note along with it.  This note can be used for many things - including telling someone when they sent the Hail and how long they will listen for a connection.  The note is displayed on the Hail notification dialog when the person receives it.











Q.  I don't understand what the difference is between the Monitor ON/OFF button and the Listen ON/OFF button?





A.  The Monitor button when it is ON (Red) checks your mail box at your Pop mail server at regular intervals to see if you have any Hail messages there from another SecureCom user.  Usually, after you connect with someone and you don't expect any other calls you can turn this monitor off.  The Listen button when it is ON (Yellow) signifies that SecureCom is waiting for a TCP/IP connection attempt - a TCP/IP connection attempt most likely resulting from you Hailing some one and waiting to see if they are on the net and want to connect.  Most of the time the user does NOT need to worry about the state of the Listen button unless you are trying to do a Manual Connect.











Q.  Then how is "Direct Hail monitoring" different from the Monitor ON mode?





A.  Both the Monitor ON (Red) mode and the Direct Hail monitoring listen for Hail messages.  However, the Monitor ON mode checks your Pop mail server for e-mail based Hail messages and the Direct Hail monitoring actually starts a small TCP/IP server inside SecureCom and listens for a direct TCP/IP request for a connection.  Both systems can be ran independently of one another.  











Q.  If I am not monitoring for e-mail based Hail messages when they are initially sent they are still in my mail box the next time I do monitor or download my mail.  What happens if I am not monitoring when a Direct Hail is sent?





A.  If you are not monitoring for a Direct Hail when it is sent then there is no record recorded anywhere and you will never know about it.  Direct Hailing is loosely analogous to yelling for someone.  If they don't hear you then they never knew that you yelled.  E-mail based Hails are loosely analogous to real mail (albeit, much faster).  The mail stays in your box until you pick it up.











Q.  How fast is an e-mail based Hail?  When I send it how long does it take to get to the sender?





A.  There is no 100% sure answer to this and it varies slightly depending on various factors such as the amount of traffic on the internet and the state of your (and other) ISP's server.  Generally, in practice, most e-mail Hails are delivered in 5-30 seconds to most end points.  At least, that is, in the United States and North America.  This hasn't been tested in practice in many other countries.











Q.  How fast are Direct Hails?





A.  As fast as the internet is at any moment.  That could be almost instantaneous to sometimes as long as 5-15 seconds.  Usually if the Hail message takes as long as 15 seconds to get there the chances for a solid connection are slim.  It would tend to indicate that the "path" between the two people trying to communicate may be going through some very slow servers or being routed all over the place.











Q.  When I hail someone - how long should I wait to see if they answer?  how long CAN I wait?





A.  If you Direct Hail someone and don't get a response in a minute or so you can be fairly sure that the party you want to communicate with is not monitoring and/or doesn't want to talk.  With E-mail based Hails it is a little different.  If I want to talk to my friend in New York City, I send him an e-mail based Hail message, minimize SecureCom, and go on and do something else while I am logged onto the net.  If he logs onto the net 2 minutes later, 20 minutes later, or hours later (and I am still on and my IP address hasn't changed) he can answer my Hail and Voila!  - SecureCom pops up and we are connected.  In fact, you could Hail numerous friends who have SecureCom and wait for any and/or all of them to answer while you do something else. 











Q.  Can I talk with more than one person at a time?





A.  Yes and no.  You can NOT talk to more than one person on a single SecureCom session BUT you can run numerous sessions and talk to many people at the same time.  SecureCom will hopefully add "group chat" capability in version 2 later this year.  This would allow more than one person to connect to the SAME session and let you have round table communications.











Q.  If I can't talk to more than one person at a time per session what do I do IF someone Hails me while I am already chatting to someone?





A.  Answer the Hail and press the connect button.  Even though this person can't be "added" to your current chat session SecureCom will start a NEW session (sometimes right on top of the old one .... so you may have to take the mouse and move it over to see your original session) and connect you with them.  Both sessions are completely independent and neither of the parties know that you are connected to anyone but themselves.











Q.  What happens if I try and Hail someone else while I am currently chatting to somebody else?  





A.  If you Hail someone else while you are already connected with somebody then SecureCom will start a NEW session and put it in Listen ON mode to await a connection from the person you JUST hailed.











Q.  How many multiple sessions can I run this way?  





A.  I really don't know.  I have not tested over 10 concurrent sessions because I run out of screen real-estate and fingers .....  I suspect you can run as many concurrently connected sessions as your system memory and sanity allows.











Q.  Why do I occasionally lose a connection?





A.  The internet, unlike the telephone system, was not originally intended to be a real time communication system for the masses.  It is not as reliable as telephone communications for real time use ..... though this is improving and getting better.  And like our Interstate highway system, the "info highway" can have it's share of "accidents" and "traffic jams" resulting in lost communication sessions.











Q.  So, now that I have SecureCom up and running where are some people I can talk to?





A.  SecureCom was not intended to be a general "chat" program or be like CB Radio.  It is not like a "party line" type "chat" application like ICQ is.  SecureCom was primarily made to connect 2 people for private and secure communication.  If you want to get on the internet and talk to many people and/or be anonymous then this application may not be for you.  











Q.  Then just how do I use SecureCom?





A.  Most users buy 2 (or more licenses) and give a registered copy to a friend, relative, or business partner.  Then they arrange general or loose schedules to talk with these people.  They know who they want to talk to and with SecureCom they can have some peace of mind knowing that they are not talking to a complete stranger and that their conversation is not public.











Q.  Why can't I just buy one license and send copies to my friends?





A.  You can ... BUT they must also register and pay for their own copies to keep from seeing the Shareware "bug" dialogs.  If you send them YOUR registration KEY file it won't work properly.  If two people try to talk using the same exact KEY file the connection will terminate.  Each user must have their own KEY file.  A single license for SecureCom ($15.00) buys you a single KEY file with your name attached to it.











Q.  Are there other versions of SecureCom available for all operating systems?





A.  Presently there are 2 versions of SecureCom.  One for Windows 95/NT and the other that works on Windows 95 and Windows NT.  They are completely and fully compatible.  There is also a Java version being coded and hopefully it will be finished in a few months.  This will, at least theoretically, give users of any O.S. a version of SecureCom they can use.











Q.  So, can I talk to and send files from my Windows 95/NT system to my buddy's Windows 95 system using SecureCom?





A.  Absolutely yes!  It's fully compatible. 











Q.  I use AOL (America On Line) for my internet connection.  Will SecureCom work on AOL?





A.  The SecureCom Windows version will work on AOL using their 3.x version software (and probably their 4.x software when it is released) on Windows 95.  it will NOT work with AOL on Windows NT.  And it hasn't been tested with the Windows 95/NT version and AOL.  Read the section for AOL users for details. 























